
RF Explorer for Windows Cumulative Release Notes  page 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RF Explorer®
 

RF Explorer for Windows Release Notes v3.21.2501 

Updated to Spectrum Analyzer Standard Firmware Version 1.34 

Spectrum Analyzer Plus Firmware Version 3.43 

Spectrum Analyzer ProAudio 3.08 

Signal Generator Firmware Version 1.34 

 



RF Explorer for Windows Cumulative Release Notes  page 2 

 

 

 

 

 

RF Explorer®
 

 

RF Explorer is an affordable Handheld Spectrum Analyzer with a growing list of features.  

 

This little powerful unit is the tool you need  

to reduce the implementation time and cost  

of your next wireless project. 

 

 

 

 

 

Updates of the RF Explorer User Manual are available online. 

Please consider the environment before printing this document.  

https://www.rf-explorer.com/downloads
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Version 3.21.2501 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.34 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.43 

• Recommended RF Explorer Spectrum Analyzer ProAudio firmware: v3.08 

• Recommended RF Explorer Signal Generator firmware: v1.34 

Note: We recommend using the RF Explorer Touch application instead. The RF Explorer for 

Windows application is currently in Maintenance Mode and no longer receives updates or 

enhancements. In contrast, RF Explorer Touch offers all new developments and is compatible with 

touch screens, as well as standard mouse and keyboard setups on any Windows computer. Visit the 

RF Explorer Touch page for additional details. 

License and registration 

This software requires registration and internet connection. 

You must provide a valid registration email to receive an activation code for your computer. If you 

do not receive a valid email, check your spam folder. 

Software registration is now possible by email, useful if your computer is behind a firewall/proxy 

preventing connection to RF Explorer License Server. 

Privacy policy is available online at www.rf-explorer.com/privacy 

Enhancements 

• The RF Explorer for Windows software is now compatible with *.RFE files created by RF 

Explorer Pro using firmware v01.20 and newer. 

Fixes 
• Minor fixes 

https://j3.rf-explorer.com/rfetouch
https://j3.rf-explorer.com/rfetouch
https://www.rf-explorer.com/privacy
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Version 2.6.2106 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.33 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.29 

• Recommended RF Explorer Spectrum Analyzer ProAudio firmware: v3.08 

• Recommended RF Explorer Signal Generator firmware: v1.34 

Enhancements 

• RF Explorer software now works correctly with optional Wideband license for RF Explorer 

PLUS models, for more details visit www.rf-explorer.com/wideband 

• Windows USB drivers are now updated the first time some of the applications ran. In this 

case please make sure to accept installing them. If you receive an error message like this 

one below, please go to installed applications and run “Repair” as in some cases the USB 

drivers may have not been correctly installed. 

If you get this message: 

 
Open Windows Control Panel, go to “Uninstall a Program” and run an installation “repair”, 

then try opening the application and updating the drivers again 

 
 

• RF Explorer Signal Generator Tool is now improved to correctly work under any local 

regional settings. Before this improvement, some local Windows settings may not work well 

with decimal point. 

Fixes 

• RF Module can now be correctly changed when WiFi Analyzer is active. Before this fix some 

modules may not correctly be selected in this mode. 

• Resolution changes in sweep points now correctly honor the Named Settings configuration. 

Before this fix, changing the selected resolution may adjust to invalid stop frequency or 

span. 
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Version 2.3.2101 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.31 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.19 

• Recommended RF Explorer Spectrum Analyzer ProAudio firmware: v3.08 

• Recommended RF Explorer Signal Generator firmware: v1.31 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements 

• Includes support for RF Explorer Spectrum Analyzer PLUS sweep record storage. With this 

new feature, the Spectrum Analyzer can record sweeps while working standalone in its 

internal memory, and download it on the computer as data files for later processing  

• For more details on registering this feature visit www.rf-explorer.com/rec 

 

• High resolution mode 512 sweep points is now default working mode for all PLUS models 

with firmware 3.16 and later. 

https://www.rf-explorer.com/rec
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Version 2.02.2009.1 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.31 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.17 

• Recommended RF Explorer Spectrum Analyzer ProAudio firmware: v3.08 

• Recommended RF Explorer Signal Generator firmware: v1.31 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements 

• Includes new support for WiFi channels at 5GHz when using latest firmware, all 28 channels 

narrow channels as well as combined wide channels. 

• Improved high resolution mode for PLUS models 

• Added support for RF Explorer 4G Combo PLUS and 6G Combo PLUS models 

Bug Fixing 

• Corrected a problem using Tracking SNA with 4G COMBO PLUS and 6G Combo PLUS 

models. Before this fix some configurations may fail to correctly start Normalization step. 
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Version 2.00.1905.4 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.28 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.11 

• Recommended RF Explorer Spectrum Analyzer ProAudio firmware: v3.08 

• Recommended RF Explorer Signal Generator firmware: v1.31 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Bug Fixes: 

The software now correctly implements Start/Stop Frequency for Tracking SNA when using the new 

RF Explorer Signal Generator Combo when combined with a RF Explorer Upconverter. 

Previous to this fix, the lowest frequency may not be correctly detecting the 100KHz limit, 

restricting to higher frequency values as if the Spectrum Analyzer could not detect the introduced 

frequency offset. 

In order to correctly use the RF Explorer Signal Generator with the RF Explorer Upconverter, please 

use configuration as described below: 

• Offset dialog: 

o Checked “Frequency Offset Spectrum Analyzer for Tracking” option 

o Frequency offset = +530MHz 

• Signal Generator tab and Signal Generator Frequency Sweep tool group: 

o Start = 0.1MHz or higher 

o Stop = 250MHz or lower 

o Steps > 1 
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Version 2.00.1904.6 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.28 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.10 

• Recommended RF Explorer Spectrum Analyzer ProAudio firmware: v3.08 

• Recommended RF Explorer Signal Generator firmware: v1.31 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

• Additional configurable display options for Radio Standard including shaded background 

• Accelerated High Resolution mode for WSUB1G PLUS and ProAudio spectrum analyzers. Use 

menu Device -> Define Sweep Points to select up to 4096 resolution points. Refresh on 

screen is now incremental and twice as fast as in previous versions when using latest 

firmware. 

• Support for new RF Explorer Signal Generator Combo with editable power level and adjusted 

frequency range from 100KHz to 6GHz. 

• Improved Tracking SNA performance to 3-5 times faster when compared to previous 

versions. Improvement requires latest firmware versions for Spectrum Analyzer and Signal 

Generator. 

• Additional retry logic in Tracking SNA algorithm to reduce chance of false readings. 

• Automatic detection of missing USB device drivers and installation without external 

download required when application starts. Please follow on-screen indications to install USB 

drivers upon application request. 

Bug Fixes: 

• Updated communication logic to overcome a bug released in Silicon Labs Universal Driver 

10.x. Before this fix, RF Explorer for Windows will not detect RF Explorer device when using 

Silabs Universal Driver version 10.x. 

• Previous version settings are now correctly imported. Before this fix, in some cases after a 

new RF Explorer for Windows is installed, the previous settings were not correctly imported 

and some preferences may have started with default values. 
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Version 1.26.1805.2 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.26 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.06 

• Recommended RF Explorer Signal Generator firmware: v1.19 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

• Integrated Spectrum Analyzer device Preset Manager option, please visit www.rf-

explorer.com/preset for more details. 

• Enhancements in Radio Standard display options. 

Bug Fixes: 

• Automatic Update Remote Amplitude in Device menu includes several fixes. Before this fix, 

the device may sometimes fail to update amplitude when required.  

https://www.rf-explorer.com/preset
https://www.rf-explorer.com/preset
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Version 1.23.1711.1 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.23 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.03 

• Recommended RF Explorer Signal Generator firmware: v1.17 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

• High Resolution sweep for WSUB1G+ model: Use the menu Device -> Define Sweep 

Points to select 512, 1024, 2048 or 4096 sweep data points. The higher the resolution the 

longer the sweep scan time. To get back to standard resolution select 112 sweep data 

points. 

Note: This new feature is currently in BETA and may not work correctly with all functional 

modes of the analyzer. 

Note: The analyzer LCD screen is disabled in high resolution mode. 

Bug Fixes: 

• Axis marks in low frequency: low frequency ranges, supported by WSUB1G+, are now 

correctly labelled in the frequency axis. Before this fix, frequencies in range lower than 

10MHz could sometimes incorrectly display 0MHz. 

• Undo All Zoom: this feature now works correctly in all scenarios. Before this fix, changes in 

device configuration after doing a zoom or pan could prevent the Undo All Zoom to correctly 

restore initial zoom settings. 

• Waterfall disabled in WiFi Analyzer mode: The waterfall modes are now disabled when 

WiFi analyzer mode is selected. In previous versions the waterfall may display confusing 

data when the WiFi analyzer was enabled. 

• Amplitude offset corrections: Several improvements were added to correct scenarios 

where a combination of Offset dB, amplitude correction files and WSUB1G+ Input Stage LNA 

or Attenuator may incorrectly display data on screen. 

• Reset Tracking SNA normalization data: additional scenarios added to properly reset 

invalid normalization data when it is no longer reliable. The application will now correctly ask 

for new normalization step every time is required. Before this fix, situations such as 

disconnecting and reconnecting the Signal Generator may not reset the normalization data 

and may lead to incorrect tracking if a different device was connected. 



RF Explorer for Windows Cumulative Release Notes  page 11 

 

Version 1.17.1710.3 

• Recommended RF Explorer Spectrum Analyzer Standard firmware: v1.23 

• Recommended RF Explorer Spectrum Analyzer Plus firmware: v3.02 

• Recommended RF Explorer Signal Generator firmware: v1.17 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

• Support for new RF Explorer WSUB1G PLUS spectrum analyzer. The implemented support 

is basic but expanded features will be added in an upcoming release, such as Preset load/save 

to computer, etc. 

 

• Culture neutral files: the data files read and stored by this new version, are all compatible 

with any region of the world. This include RFE data files, CSV files, Normalization, Limit lines, 

Radio Standards, etc.  

The files no longer depend on local cultural computer configuration, which in previous versions 

prevented comma “,” as decimal separator to be incorrectly interpreted if the file was shared 

with computers where dot “.” is decimal separator. 

As result of this change, you may need to recreate Normalization files if you try to reuse from 

older versions and are working with a computer where comma and not dot is decimal separator. 

 

• Frequency Offset is now available in Tracking SNA. This advanced feature enables 

sophisticated tracking such as required by Upconverter and Downconverter mixers, frequency 

multipliers, etc. 

 

 
The additional checkbox allows selecting where the visual frequency offset is being applied: to 

the Spectrum Analyzer (checked) or the Signal Generator (unchecked) 

 

• Auto-collapse COM connection ToolGroup: After a spectrum analyzer or signal generator is 

connected to USB COM port in the corresponding ToolGroup, it will collapse to automatically 

free screen area to the other ToolGroups. It can be easily expanded clicking on the ToolGroup 

text (such as “Analyzer ON”) 
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• Automatic data file save and recycle: A new feature allows data files (either binary or CSV) 

to be automatically saved at certain intervals. This is a feature requested by many customers in 

need of periodically storing RF activity for review or export to external systems. 

The configuration of this new feature is available in the Configuration tab: 

 

  
 

By activating the RFE Data File option and defining a valid number of seconds in DELAY, files 

will be generated with compact binary format in the <My Documents>\RFExplorer folder using 

standard file name format RFExplorer_SweepData_YYYY_MM_DD_HH_mm_ss.rfe.  

Files automatically generated with this name format will be automatically deleted by the 

application if files older than AUTO DELETE are found. This new feature helps to keep the 

number of obsolete data files under control with no effort. 

Activating the Single CSV option works exactly the same as RFE Data File, with the difference of 

text comma delimited files being saved. Same normal restrictions for Single CSV files apply as 

when saving a file manually: only one trace can be active on screen for the Single CSV file 

feature being able to work. 

Bug Fixes: 

• Fixed WiFi analyzer mode: Changes implemented in firmware and software recently worked 

incorrectly in previous versions and may not correctly represent WiFi channels on screen. This 

new version corrects the problem for 2.4Ghz and 5Ghz bands. 

 

• Adapted to firmware v1.23 data points fix: New Spectrum Analyzer firmware v1.23 

correctly calculates sweep steps (111) and data points (112) and therefore requires this 

matched RF Explorer for Windows version to correctly display accurate information on screen. 

Upcoming versions will enable configurations with much higher number of data points (up to 

4096) stay tuned! 

 

• Named Settings configurations fix for delta markers: the updated code now correctly 

save and restore delta markers frequency offset locked option. Before this fix, the frequency 

offset locked may be ignored when changing to a different configuration. 

 

• Power Channel fix for data files: the Power Channel feature now correctly updates and 

recalculate power correctly when sweep data comes from a loaded data file. Before this fix, the 

channel power may not be correctly updated and calculated with correct power levels. 

 

• Improved Radio Standard rename and delete options: New functionality correctly 

rename and delete a Radio Standard from all associated Named Settings configurations where it 

may be used. Before this fix, only current Named Settings configuration was updated.  
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Version 1.17.1703.8 

• Recommended RF Explorer Spectrum Analyzer firmware: v1.17 

• Recommended RF Explorer Signal Generator firmware: v1.17 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

• Radio Standards: New feature custom definition of Radio Standard channels. You can now 

import standards or define your own channels to be included in the Spectrum Analyzer graph of 

RF Explorer for Windows. Each channel in a Radio Standard will display: 

o Channel name 

o Visual shape of the actual bandwidth and channel position 

o Computed individual power channel 

All parameters of a Radio Standard can be configured in the menu option View -> Radio 

Standards -> Configure Radio Standards. This will open a configuration dialog to setup 

parameters, select which Radio Standards are visible (up to 10 at any given time), import new 

Radio Standard definitions, etc. 
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An example of active Shure H4E band active, with channel 4 in clear use, with total channel 

power of -44.39dBm. 

 

 

For simpler display, channels which are not fully inside the span are excluded from the view. 

Only fully covered channels are displayed as otherwise power channel calculation would be 

incorrect. 

This effect may be more evident in overlapping channel configurations such as WiFi 802-11b. 

By centering at 521.175Mhz (Channel 4 center frequency) and reducing the span to better 

shape the channel 4 only, we can monitor activity to identify if it is coming from expected 

source (shown below) 
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In addition, we can easily identify if some sort of unintended signal is occupying our channel. An 

example shown below is a wideband interferer, not the mic transmission we expected. 

 

This release includes 3 examples you can use for Radio Standards: 

o RadioStandard_WiFi-2.4GHz-802-11b-g.rfers 

o RadioStandard_WiFi-5GHz-802-11a.rfers 

o RadioStandard_UHF-Shure_Wireless-UHFR_Band-H4E_Group2.rfers 

These files are text files you can edit with the tool of your choice (e.g. notepad – although we 

recommend a better tool such as Notepad++) using the ones provided as examples. 

To load any of these Radio Standard files, or the ones you defined: 

1. Open the Radio Standards Settings dialog 

2. Click on [Import from File…] 

3. Navigate and select the intended *.rfers file 

4. You can now include a suitable description, change color and channel shape, rename it, 

etc. 

5. To make a Radio Standard visible, check it on the list. Note: a maximum of 10 Radio 

Standards can be selected as visible at any given time. 

Note: Radio Standards feature is a work in progress, you can expect additional functionality and 

extensions in upcoming releases. An upcoming feature will allow you to download standards 

defined in a global repository from the web. 

Current limitations: 

o Channel power is calculated on Realtime trace. This is the most convenient option for 

most users. On future release additional traces such as Average and Max will be included 

for selection. 

o With limited number of sweep scan points in current firmware (112 points) narrow band 

channels cannot be correctly calculated and displayed in a wideband span. For better 
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accurate display, select narrow span so each channel includes at least 10% of span. A 

future firmware will enable selectable higher resolution sweep points to make wideband 

scan feasible for narrowband channels.  

In the meantime, you can selectively navigate through the span using [Start <50%] and 

[End >50%] for easily traversing a wideband range piece by piece.  

You can also select and save different configuration names for each frequency range and 

use the Name Settings combo box to quickly restore any required configuration. 

o [Import from Web…] is under development. 

• Added Frequency and Amplitude Offset control from the Windows application. This feature 

allows easy control of external amplitude changes (such as amplifier or attenuator) as well as 

frequency up-conversion or down-conversion (such as RF mixer). 

To change offset, use the new menu option “Device -> Configure Offset…” 

 

 
 

By changing the Amplitude Offset, both device and Windows application will display same 

adjusted amplitude on screen. This is the same as using the actual device ATTENUATOR MENU 

and setting a specific offset value in OffsetDB parameter. The device will be updated after 

clicking OK button. 

By changing the Frequency Offset, only Windows application is adjusted, the device will 

automatically switch LCD screen OFF (if it was ON) to avoid confusion. A future firmware will 

enable device Frequency Offset too. 
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• Several enhancements in Markers: 

o New “Frequency Offset Locked” feature (FOL). This new option enhance the standard 

Delta Markers by enabling a dynamic follow-up of the Delta ID to the Delta Marker. 

 
 

When the FOL feature is enabled in above example, the Marker [2] will always be at 

5MHz higher than Marker [1]. As the Marker [1] changes frequency to track the Peak, 

the Marker [2] will calculate absolute and delta amplitude on every new position. This is 

an extremely useful functionality to measure side-bands, noise or image frequency of a 

CW or modulated channel shape. 

When FOL is not enabled, the Offset defined for the Delta Marker is static and used only 

at the marker definition time. It will not follow the reference Marker if it changes 

position. 

o A marker can be now enabled and located on a particular position by double-click. In 

previous release, the double click would be ignored if the marker was not already 

enabled. To automatically locate a marker on any position by double-click: select the 

Marker ID you want to locate, double-click on any signal trace position, the marker will 

be located there and enabled if it was not. 

• Added an option to start RF Explorer for Windows without OpenGL 3D graphics enabled. In 

some computers, old video drivers or insufficient CPU speed may cause problems. The new 

shortcut (No OpenGL) will start RF Explorer for Windows without 3D acceleration requirements. 

The Waterfall screen will not be available in this mode. 

 

 

• WiFi Analyzer screen mode in RF Explorer for Windows is now available for 5GHz band. Note 

this is limited to the same 13 channels displayed on the device and, therefore, will show a large 

empty gap between low number channels and high number channels. 
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If you need to inspect other 5GHz WiFi channels, you can use the new RadioStandard feature 

and load the WiFi defined configuration. 
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Version 1.15.1610.4 

• Recommended RF Explorer Spectrum Analyzer firmware: v1.16B03 or v1.15 

• Recommended RF Explorer Signal Generator firmware: v1.15 

• Note: WindowsXP computers may need to apply a Microsoft Hotfix to properly install this 

version. Please install software from WindowsXP_MSI45_Hotfix.zip if normal install fails in 

WindowsXP. 

Enhancements: 

• This version introduces RF Data Sniffer capabilities as Beta feature. In order to use Sniffer 

features, please read the document “RF Explorer for Windows DRAFT Documentation - 

sniffer.pdf” included in this release package. 

 
• To enable Sniffer data you need to upgrade RF Explorer Spectrum Analyzer to firmware 

v1.16B03 – you can easily downgrade it to v1.15 anytime. 
• Several enhancements in Markers: 

o Markers allow now Delta value reading – you can display difference between two 

markers as delta in dB. This is useful to measure harmonic, noise levels, carrier dBc, etc. 

 
o Markers can be allocated on screen at any arbitrary frequency with a double-click mouse 

(not available for auto-peak Marker 1) 

o Marker display is now better organized, display is now bold for marker label in the right 

marker data control area. 

• Display grid now include a continuous line trace for major grid ticks. In earlier versions this was 

presented with dotted lines which made it hard to read at certain wide zoom configurations. 

• Updated to latest OpenGL libraries to enable maximum compatibility with video card drivers. 
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Bug Fixes: 

 

• Fixed problem with Windows Text Scale different than 100% in Windows Vista and Windows 7. 

Before this fix, some Text Scale OS settings such as 125% or 150% may lead to inconsistent 

Zoom selection inside Spectrum Analyzer or RF Sniffer data graphs. 

• Fixed a performance problem when displaying Spectrum Analyzer graphs with a very narrow 

span (<1MHz) in some configurations. After this fix the display performance is independent of 

selected span. 
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Version 1.15.1607.6 

• Recommended RF Explorer Spectrum Analyzer firmware: v1.15 

• Recommended RF Explorer Signal Generator firmware: v1.15 

Release date: CET July 31st , 2016 

Bug fixes 

• Fixed a problem where Frequency Calibration (from Configuration screen tab) would not 

correctly calibrate 3G Combo model. 

• Improved numeric check in several Analyzer and Generator edit boxes. 
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Version 1.15.1607.5 

• Recommended RF Explorer Spectrum Analyzer firmware: v1.15 

• Recommended RF Explorer Signal Generator firmware: v1.15 

Release date: CET July 8th, 2016 

 

Enhancements: 

• Included full support for Frequency and Amplitude Sweep using RF Explorer Signal 

Generator v1.15 – for more details check Signal Generator user manual 
• Added ToolGroups for Amplitude Sweep and Frequency Sweep in Signal Generator tab 

screen 

 

• RF Explorer Signal Generator now disables LCD backlight and announce TRACKING + 

POWER ON to alert on current functionality when working in SNA mode. 

• Finished final release for Signal Generator features with production quality, no software 

stage is in beta level beyond this point. 
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Bug fixes 

• RF Explorer for Windows now remembers last computer folder used to read and write files. 

Before this fix, default location in My Documents was always suggested for file location, this 

was inconvenient when a different folder was intended to be used. 

• The Report tab now correctly dump screen contents from Signal Generator or Spectrum 

Analyzer. Note: to capture Signal Generator screen, make sure a Spectrum Analyzer is not 

connected at the same time. 

• The Spectrum Analyzer tab now correctly adjust Top amplitude when an external attenuator 

or amplifier is being used, and OffsetDB was specified in the unit. Before this fix, the Top 

amplitude may not be enabled to increase in a way that correctly display high power levels. 
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Version 1.12.1604.3 

• Recommended RF Explorer Spectrum Analyzer firmware: v1.12 Beta 31 

• Recommended RF Explorer Signal Generator firmware: v1.12 Beta 15 

Release date: CET Apr 13th, 2016 

 

Enhancements: 

• Automatic connection of Spectrum Analyzer and Signal Generator device. This is a major 

improvement to allow transparent operation of connected devices in any configuration. If you 

are using a RF Explorer Spectrum Analyzer and a Signal Generator together for SNA or other 

purposes, the easiest way to work with them now is as follows: 
o Connect Spectrum Analyzer to USB 
o Connect Signal Generator to USB 
o Start RF Explorer for Windows application. 
o Both devices will be automatically connected to correct ports and enable SNA display 

automatically. 

• Manual connection of devices is still available as usual, in all cases the application will try to 

connect the right device to the right port as soon as the connection is made. 

• Aligned waterfall 2D view on main Spectrum Analyzer screen. Now is possible to have a fully 

aligned frequency view on both displays. 

• Waterfall dedicated tab view is now independently configured from that of Spectrum Analyzer 

tab view. This is best fit for a convenient 2D waterfall on Spectrum Analyzer and a full featured 
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3D view on Waterfall view. Configuration settings such as transparency and Realtime/MaxHold 

settings for waterfall are also independent in both views. 

 

• Default settings are now Dark Mode and Spectrum Analyzer view configured to include waterfall 

2D. This setting can be reconfigured by user anytime. If you do not need or like the Waterfall 

view, use menu View->Include Waterfall in Main Screen->None. 

• Configuration device icon is now disabled by default, to allow waterfall alignment. You can 

enable the device icon again using menu Device->Show RF Explorer icon… 

Bug fixes 

• Waterfall screen display is now properly updated when “Data Sample” index is manually 

modified while Hold mode is enabled. Before this fix, waterfall display may not update with 

correct data when Data Sample was manually modified. 

• Frequency Markers are invalidated in Wifi Mode if they are out of range. Before this change, 

some markers could read incorrect values while Wifi Analyzer mode was enabled. 

• Frequency Markers no longer get out of screen if too many are enabled. Before this fix, a long 

list of markers on screen may actually go beyond application markers area. 
  



RF Explorer for Windows Cumulative Release Notes  page 26 

 

Version 1.12.1601.5 

• Recommended RF Explorer Spectrum Analyzer firmware: v1.12 Beta 26 

• Recommended RF Explorer Signal Generator firmware: v1.12 Beta 15 

Release date: CET Jan 29th, 2016 

Release notes for this version accumulate a number of improvements and bug fixes, including 

details from earlier versions v1.12.x not fully documented in this document before. 

 

Enhancements: 

• Fully supported SNA tracking for all RF Explorer models except 2.4G. This model will be 

supported in the near future. 

• Added median average to improve noise rejection in SNA tracking display. 

• Software is fully integrated with internal calibration available in RF Explorer Spectrum 

Analyzer and RF Explorer Signal Generator. Please upgrade your unit to latest firmware 

versions available at www.rf-explorer.com/downloads  

• RF Explorer firmware uploader tool is now supported in Linux, Windows and MacOS X. For 

more details please visit www.rf-explorer.com/upgrade . This tool now also support 

command line mode for easy use in headless devices such as Raspberry Pi and remote 

servers – you can now virtually upgrade your RF Explorer firmware from any system! 

• Support for configurable and auto-generated Limit Lines, including optional sound alarm 

when signal does not fit inside limit lines. 

• Normalization data can be fully stored in separated files for easy reuse later. 

• Signal Generator tracking results can be saved as CSV and standard S1P files. Note: files are 

considered S1P because only one parameter can be saved at a time, regardless if it is S11 or 

S21. If it is a 2-port S21 measurement, rename the file manually. Future enhancements will 

https://www.rf-explorer.com/downloads
https://www.rf-explorer.com/upgrade
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allow combination of multiple readings, such as S11 and S21 to be displayed together and 

saved to a S2P file. 

• User can select "Insertion Loss" or "Return Loss" graphical Y axis label for Signal Generator 

trace. This include "Linear VSWR" correctly calculated for easy VSWR display. Note: you 

need an external directional coupler to measure return loss and VSWR as described in this 

online tutorial: link. 

 

• All Tool Groups in control area are now collapsible to make it easier fit in small screens. This 

feature is developed from ground up specifically for RF Explorer for Windows. As depicted in 

the image, circled in red, there is a new arrow button available on each toolset group and 

located top-right; by clicking on it you can collapse the toolset so no longer takes screen 

space and makes room available for other controls. 

 

Once collapsed, the toolset group will display a brief informative text. In this case to show 

the Analyzer is connected (Analyzer ON). By clicking again on the arrow button the toolset 

group gets expanded back. 

 

https://j3.rf-explorer.com/sna-how-to-measuring-reflection-return-loss.html
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• This version adds Tool Group for Markers, so it is now easier than ever to set a marker 

quickly on screen (optionally you can use Markers menu as in earlier versions) 

 

• Markers are available for SNA Tracking as well as Spectrum Analyzer. They work virtually the 

same in Spectrum Analyzer and SNA, with the important difference in marker 1: while it 

detects Peak value in Insertion Loss mode, it will automatically change to negative Peak in 

Return Loss mode. 

All other markers from 2-9 can be defined at any arbitrary frequency, same as with 

Spectrum Analyzer. Values of markers defined for SNA and Spectrum Analyzer are 

independent and stored in configuration settings, so you can define markers for a particular 

configuration and restore them easily anytime. 

 

• Added Tool Group for most usual visual settings including different trace modes as well as 

signal thickness, grid, etc. 

 

• Added on-screen tooltips for most controls and functions. To use them and get sensitive 

help, just place the mouse cursor over any control and will display informative text. 

• Remote Screen tab is now available for Signal Generator too. In order to use it, the only 

device connected must be the Signal Generator, otherwise the Spectrum Analyzer takes 

precedence. 

• Waterfall screen supports now arbitrary data points. This enable data from RF Explorer 

RackPRO and other future models and firmware revisions to properly display large datasets 

in the Waterfall screen. 
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• Optimized internal data calculation and RAM storage for Waterfall screen. This may be 

noticeable for a better performance and lower memory footprint in small systems such as 

Windows tablets and netbooks. 

• Sweep frequency and power settings are now stored with named configuration settings 

• User configurable title text graph added to both spectrum analyzer and SNA graph 

• Support for external amplitude correction files in Spectrum Analyzer. 

• Support for amplitude in dBm, dBuV and Watt. 

• Channel power meter 

• Additional remote device control modes 

• Auto-scale amplitude function using right-side accelerator buttons 

• Added all models correction files *.RFA so they are installed automatically, no need to 

manually handle them. 

• Updated power channel to adjust for OffsetDB from the device 

• Updated power channel to follow max/min range values from analyzer settings 

• Updated power channel context menu for correct option handling 

• Updated dark color mode to correctly read legends 

• WiFi Analyzer graph mode enabled. You can now use the WiFi analyzer mode on your PC as 

soon as it is enabled on the RF Explorer device. 

Fixes: 

• Fixed a problem where data files folder could not reliably use a network shared folder by 

default. 

• Corrected a scale fit problem in the RF Explorer device icon image in the Configuration Tab 

screen. 

• The configuration settings and user preferences configured in the RF Explorer for Windows 

application are now reused from version to version. 

• The application setup has been migrated to a different package. This should be transparent 

to all users and OS configurations but if you experience any problem in the setup process 

please contact us. 

• Corrected measurement data point on Signal Generator screen to be dB (as opposed to 

incorrect dBm reading earlier version) 

• Corrected Spectrum Analyzer trace color mismatch in MaxHold and Min. 

• Optimized communication response between device and USB connection to minimize 

configuration screen retries. Before this improvement, the device may resend configuration 

screen 2 or even 3 times to the Windows application, resulting in flashing and unnecessary 

refresh. 

• Fixes in markers under SNA on several cases where lost or changed unexpectedly 

• COM port larger to accommodate comfortably up to COM999 values 

• Fixed crash when editing dB value in Limit Lines dialog box 

• Automatic and resilient detection of any USB combination. Prior to this fix, the application 

may confuse ports and not complete connection if the device was plugged on a different 

USB port in the computer than last time used. 

• Typo in several message text and menus (thanks users Shaun O'Sullivan and Stewart 

Andreason) 
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• Sometimes SNA normalization or tracking could not start if frequency was right on module 

frequency boundary (e.g. starting right at 15MHz in a 3G Combo model may have not 

worked successfully in some cases) 
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Version 1.11.1311 

Release date: CET Nov 22nd, 2013 

This version includes important enhancements and features: 

• Waterfall 3D and 2D using high performance, high quality OpenGL graphics library. 

 

• Waterfall can display on dedicated tab as well as in the main Spectrum Analyzer screen, and 

options for display different perspective views and waterfall options are available on a right-

click, context sensitive menu. 

 



RF Explorer for Windows Cumulative Release Notes  page 32 

 

• Signal shape in Spectrum Analyzer screen can be optionally filled with solid colors for easier 

visualization 

• Signal shape can optionally remove smoothing and use straight segments 

• Clean buffer option will now clean the internal RF Explorer device buffer as well to remove 

any old signal cached in MaxHold mode 

• Controls and Text in the Graphical Interface is adapted to resize correctly under text size 

scaled in Windows and has been thoroughly tested with different setups including 125% and 

150% text scale. 

• List of last data files .RFE opened are now available for easy access in the file menu. 
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Version 1.11.1307 

Release date: CET Jul 24th, 2013 

This release includes full support for RF Explorer firmware v1.11, as well as new important 

capabilities: 

• Full compliance with firmware v1.11 – note some features will not be available if you do not 

upgrade your firmware to the latest version. 

• New Device menu with selection of active RF module if a 2-port RF Explorer model is 

connected. 

• Graphic, quality 3D representation of the connected RF Explorer model to better understand 

the active RF connector. It also includes an antenna representation but take the antenna 

shape as an indication only, the software has no way to know the actual antenna connected, 

or if there is an external RF source being used instead of an antenna. 

• The Spectrum Analyzer screen adds the currently selected Configuration Setting text as part 

of the title of the graph. This helps to reference the meaning of the captured signal in a 

print or a bitmap file. 

• Max Hold mode is available now in the View menu, in addition to the pre-existing Max Peak 

mode. 

• The Automatic LCD OFF option has been moved to the new Device menu. This is for 

consistency but functionality does not change. 

• The Spectrum Analyzer includes now timestamp. This feature allows knowing with 

millisecond precision the exact time data was captured, so it can be joined with GPS position 

data or other events. 

• The Remote Screen includes now timestamp. In addition to that, finer control were added to 

allow for B/W or color capture, as well as a text header with indication of capture time and 

model used on screen for reference. 

• A more advanced print facility, available from the File menu, allows now to print the Dark 

Mode configuration in white background to save toner and make prints easier to read. 

• The internal Spectrum Analyzer capture buffer is now able to store 10 million sweeps, 

thanks to new advanced memory management. 

• The internal Remote Screen capture buffer is now able to store 64K screens. 

• The buffer for Spectrum Analyzer and Remote Screen can be independently cleared from the 

File menu, Reinitialize Data Buffer command. It will ask for confirmation and will clear the 

buffer based on the current screen on focus. 

• RF Explorer data files include timestamp of each capture, so the persisted data is smarter 

and able to display capture time when restored. This include these file formats: 

o .RFE – standard RFE data files. 

o .RFS – standard RFS screen capture files. 

o .CSV – Cumulative CSV files include date and time on each sweep row. Simple CSV 

files remain with old format and no timestamp as they are compatible with 3rd party 

coordination software tools. 

• As result of these improvements, the file format is now v002 and therefore not readable 

from older versions of the RF Explorer for Windows. However, this new version of the 
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software can read older v001 format as well as new v002 format. If you deliver files to other 

users, make sure they work with the latest version of the software. 

• There are new sample files available in the Examples folder in the RF Explorer installation 

program group.  

• A new Help menu is available at the right of the menu bar. It includes direct access to online 

information, manuals and the About box. We are working on a much improved and updated 

version of the RF Explorer User Manual so all the information you may need will be just a 

click away. 

• A large number of workflows have been improved and bugs fixed based on user feedback 

and reports from different computer configurations. The continuous support of the RF 

Explorer community makes all these improvements possible, and we keep investing on 

making this software better and more capable based on feedback. 

• The underlying software SDK is now revamped in reusable components to make 3rd party 

integrations much easier. The foundation of all this functionality is the new 

RFECommunicator component, which encapsulates all the complexity of dealing with USB 

protocol for you. We will dedicate a full section in the documentation for reference of this 

powerful component which makes it possible to create your very own application in a few 

minutes, as well as integrate it with pre-existing software tools. As this is a layer on top of 

the standard USB communication protocol, you create applications and tools based on the 

low level documented protocol or with this new advanced control, your choice, both options 

are available. If you are interested on developing software for RF Explorer, place your 

questions and comments at www.rf-explorer.com/forum 

 

https://www.rf-explorer.com/forum
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Version 1.09.06 

Release date: CET Mar 21st, 2013 

This is a bug fixing release. It resolves a problem experienced by some users where the application 

will fail to load name settings from disk, and sometimes even crash. 
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Version 1.09.05 

Release date: CET Dec 14th, 2012 

This version includes a number of enhancements:  

• Internal memory buffer size increased to 30000 samples, previous versions limited it to 

10240 samples. Assuming an average of 10 samples/sec, you can get about an hour worth 

of data in the memory buffer. 

• New Continuous data log feature implemented, it is active by default in menu File-> 

Continuous Log to RFE data file – When this new feature is enabled, it will store 

information forever as long as there is enough HD space, creating successive .rfe data files 

automatically everytime the buffer gets filled and starting all over again. 

 

• If continuous data log is not active, the application won't store data automatically in files, 

but it will keep receiving signal data forever and won't stop when the buffer is full: it will just 

clear it and start all over again. Previous versions set the application On Hold and stopped 

capturing more data to protect the buffer from being overwritten. 

• Signal graph uses smoothed curves (splines) now in the Spectrum Analyzer screen, for a 

softer, more pleasant display. The splines have very little tension to avoid any distortion to 

the real signal data. 

Bug fixes included: 

• When connecting a RF Explorer with an old firmware version, it will show now a single 

popup with firmware version alert. Previous to this fix, there may be 2 or more popups with 

the same information displayed. 

• Named Settings file has been moved to a new location, in the AppData global folder where 

there is no access right restrictions to store application data. Previous to this fix, Windows 

Vista / Win7 and Win8 users with UAC enabled may experience problems storing named 

settings. When the new application version is loaded for the first time, it will import old 

named settings from the previous location, if it exists. In that way you do not lose the old 

settings when upgrading to the new application. 

• Named settings work fine now in both scenarios: RF Explorer unit connected and 

disconnected. Previous to this fix, certain combination of settings with the unit connected 

may not really honor the values on screen and will display bogus frequency information, as 

the RF Explorer unit and the Windows software may be not in sync. 
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• Performance improved when loading very large .RFE files. Previous to this fix, the tool may 

take several minutes to load a RFE file with thousands of samples. 

• Reduced verbosity of the report tab window, to keep only meaningful information to the 

average user by default. If you need to enable detailed information, check the new Detailed 

Debug Info checkbox in the Report tab window anytime. Note detailed information is still 

persisted to Report log file, so it is available for client support and detail research in case of 

troubleshooting is required. 
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Version 1.09.04 

Release date: CET Oct 10th, 2012 

This version includes a number of enhancement and bug fixes: 

• There is a powerful facility to persist configuration settings with descriptive names, so they 

can easily be restored on demand. You can use this powerful feature to easily setup the RF 

Explorer to configurations you commonly use. More information on this feature in the online 

manual in the “Configuration named settings” section. 

• The RF Explorer for Windows now exports a simplified CSV file format as required by IAS 

and other Frequency Coordination applications. You can also select the CSV delimiter 

(comma by default, but can be tabulator and other symbols). 

• There are now tooltips to help on understanding what the different functions and commands 

are for. 

 

• The user can now select the default location for data files (auto RFE file, bitmaps, CSV, etc) 

in the Configuration tab screen. By default it will go to My Documents\RFExplorer folder. 

• A bug that prevented the Peak values on screen to be exported the bitmap or being visible 

when the RF Explorer device was on hold has been resolved. This issue was introduced in 

previous version v1.09.03. 

• An internal adjustment on scale is now done automatically when a RFE file is loaded. This 

guarantee too low or too high amplitude signals will remain on screen after the file is 

loaded. 

• An optimization on the way the Remote Screen works is now in place, so the Auto LCD OFF 

feature disables the Remote Screen controls to make it more obvious to the user the fact 

that a remote screen is not available when the RF Explorer device doesn’t actually draw 

information on screen. 
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License 

RF Explorer embedded firmware is copyrighted © by Ariel Rocholl, 2010-2025  

RF Explorer for Windows is Open Source software released under GPL v3, so you are free to modify, 

distribute and use it based on GPL terms. Additional license options are available upon request. 

RF Explorer is a registered trademark in all EU and other Countries. 

 

Disclaimer 

This application is Open Source and available under GPL v3 license by Ariel Rocholl. The source 

code is available at github.com/rfexplorer and can be modified, updated and redistributed under 

GPL license. 

For more info on RF Explorer, please visit  

www.rf-explorer.com/forum  

For instructions to upload this new firmware in your RF Explorer unit, please visit online 

documentation at  

www.rf-explorer.com/upgrade 

Some of these new features documented below may not be available in the user manual until a 

final release is published. For questions, please go to RF Explorer forum at  

www.rf-explorer.com/forum 

You agree that the software is provided as-is, without warranty of any kind (either express or 

implied). Accordingly, we make no warranties, representations or guarantees, either express or 

implied, and disclaims all such warranties, representations or guarantees, including, without 

limitation, the implied warranties of merchantability and fitness for any particular purpose, as to: (a) 

the functionality or non-infringement of program, any modification, a combined work or an 

aggregate work; or (b) the results of any project undertaken using the program, any modification, a 

combined work or an aggregate work. In no event shall the contributors be liable for any direct, 

indirect, incidental, special, exemplary, consequential or any other damages (including, but not 

limited to, procurement of substitute goods or services; loss of use, data, or profits; or business 

interruption) however caused and on any theory of liability, whether in contract, strict liability, or 

tort (including negligence or otherwise) arising in any way out of the use of the program, even if 

advised of the possibility of such damages. You hereby waive any claims for damages of any kind 

against contributors which may result from your use of the firmware. 

https://github.com/rfexplorer
https://www.rf-explorer.com/forum
https://www.rf-explorer.com/upgrade
https://www.rf-explorer.com/forum

